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Login to Drupal 
1. Open a new web browser session. 

 Firefox works best.  Other browsers work except when using the LinkIt button. 
2. Navigate to http://psbehrend.psu.edu (or any page within the college web site). 
3. Scroll down to the bottom of the page and click on the link:  Login. 
4. Login at the Penn State WebAccess screen. 

 The dashboard is displayed which lists the pages on your site. 
 
 
Logout of Drupal 

1. At the top (right corner) of the page, click on the link:  Logout. 
2. Exit from the web browser. 

 
 
Drupal Menus 
There are two menu bars at the top of the screen.  The first one is the primary menu; underneath this one is the 
secondary menu.  The menu items in the secondary menu will change depending upon the item you select from 
the primary menu. 
 
Example of the menu bar after logging in: 

 
 
Primary Menu Items 

• Dashboard – Displays a list of all the pages within your site.  Or, you can choose to view a list of only 
those pages that are pending approval or that are unpublished. 

• Add Content – Allows you to create a new page, news item, or event item. 
• Content – Displays a list of all the pages within your site.  This view allows you to quickly search for 

pages, news, and events 
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Overview of the Dashboard 
The dashboard provides a list of all pages that you are responsible for editing.  You can view pages that are 
published, unpublished, or pending approval. 
 
Access the Dashboard 

1. From the primary Drupal menu, click on Dashboard. 

 
 

View Pages that are Published 
1. From the primary Drupal menu, click on Dashboard. 
2. From the secondary Drupal menu, click on Published. 

 A list of published pages appears.  These are pages that can be viewed by the public. 
 
View Pages that are Pending Approval 

1. From the primary Drupal menu, click on Dashboard. 
2. From the secondary Drupal menu, click on Pending Approval. 

 A list of pages that are awaiting approval is displayed. 
 
View Pages that are Unpublished 

1. From the primary Drupal menu, click on Dashboard. 
2. From the secondary Drupal menu, click on Unpublished. 

 A list of pages that are unpublished is displayed.  These are pages that are not viewable by the 
public. 
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View or Edit a Page from the Dashboard 
1. To view a page, click on the page title in the Dashboard. 

 Once you are in this view, you can also click the Edit tab to edit the page. 

OR 

To edit a page, click on the edit link (in the last column) that corresponds to the page you wish to edit. 
 This will automatically open up the page in editing view. 

 
 
Sort the Columns on the Dashboard 
You can sort each column on the Dashboard in ascending or descending order. 
 
To sort the items: 

1. Click on a column’s title. 
 
 
Search the Dashboard   
The search feature will be available at a later date. 
The dashboard allows you to search for a page by title, content type (i.e. a basic page, news article, event, etc.), 
or by its publishing state. 
 
 
Search for a Page   
The search feature will be available at a later date. 

1. In the Title box, type a word that appears in the title of the page. 
2. At the Type box, select the type of page:  Any, Basic Page, News, or Event. 
3. Click the Apply button. 
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Overview of the Tabs 
Once you navigate to a page, you will see the following tabs: 

• View – Provides an approximation of what your page will look like when viewed by a visitor.  This is 
selected by default. 

• Edit – Allows you to edit a page.  Select this tab if you wish to edit the page. 
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Overview of the Editing Toolbar 
The toolbar is very similar to toolbars that you see in other applications.   

 
 
The icon and name of each button is shown below. 
 

 Templates (to be available at a later date) 

 Select All, Cut, Copy, Paste as Plain Text 

 Undo, Redo, Spell Check, Find, Replace   

 Styles   ??? --- H1 (page title) and H3 (heading) are too similar in size 

(160%, 150%).  No style for body text (to change from a heading back to body text). 

 Bold, Italic, Strikethrough, Subscript, Superscript, Remove Format 

 Special Character 

 Left Align, Center, Right Align 

 Bullet List, Numbered Bullets, Outdent, Indent, Block Quote 

 Link, LinkIt Plus, Unlink, Anchor 

 Image, Horizontal Rule, Table 

 Source 

 Maximize 
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Create, Save, and Publish a New Page 
When you create a new page, you will see the following screen with these components: 

• Close button:  Located at the top, right corner of the screen.   
• Approval Message:  Reminder that a new page won’t be made public until it has been approved. 
• Save button:  Located at the top and bottom of the screen. 
• Title box:  Used for the title of the web page. 
• Body/Content area:  The location where you place the content for your page.  (For more information 

about the toolbar, refer to the previous section.) 
• Resize button:  Used to resize the body/content area. 
• Behrend Section:  Indicates which section this page belongs to.   
• Status:  Indicates current status of page. 
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To create and save a new page: 
1. From the primary menu, select:  Add Content. 
2. From the secondary menu, select:  Page.   
3. In the Title box, type a title for the web page. 

 Remember:  The title is part of the web page address, so keep it brief, but meaningful. 
4. Click in the body area and enter your content. 
5. For the Behrend Section, select the appropriate section for the location of the new page. 
6. Click the Save button. 

 The button is located at the top and bottom of the editing screen. 
 The page is submitted for review.  Once approved, you will be notified via email and the page will 

appear on your dashboard.  The page is available to the public once you create a link to it. 
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Edit and Save an Existing Page 
1. Navigate to the page that you wish to edit. 
2. Click the Edit tab. 

 
3. Make the desired changes to the page. 

 

 
4. Click the Save button. 
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Close a Page (without saving) 
To close a page without saving any changes: 

1. Click the Close button. 
 The button looks like this:  (a black circle with an “X”).  It is located at the top, right side of the 

editing screen. 
 
 
Preview a Page 
The preview provides an approximation of what the page will look like when viewed by a web site visitor. 
 
To preview a page: 

1. If needed, save or close an opened page. 
 The page is now in view mode. 

OR 
Click on the View tab. 
 

 
 
 
Delete a Page 

1. Click the Edit tab for the page you wish to delete. 
2. Scroll down to the lower half of the page and click the drop-down arrow for the Status field. 
3. Select Delete. 
4. Click the Save button. 

 Important:  The page is permanently deleted. 
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Unpublish a Page 
If you no longer wish a page to be available to the public for viewing, you can unpublish the page.  (The page is 
not deleted; it’s just that it can’t be viewed by the public.) 
 

1. Click the Edit tab for the page you wish to unpublish. 
2. Scroll down to the lower half of the page and click the drop-down arrow for the Status field. 
3. Select Unpublish. 
4. Click the Save button. 

 When you unpublish a page, it will be removed it from the left navigation menu (if it had originally 
appeared there).   

 Although a page may be unpublished, it still appears in the dashboard.  To see your unpublished 
pages, go to the Dashboard and click on Unpublished.   

 You can locate the page on the dashboard by searching for the page title or by the published state.   
??? --- Not working; unpublished page doesn’t appear in dashboard. 

 If you decide that you want to publish this page at a later date, you will need to re-publish the 
page. 

 
 
Republish a Page 
If a page has been unpublished (i.e. is not available for public viewing), you can choose to re-publish the page 
making it available to the public. 
 

1. Click the Edit tab for the page you wish to republish. 
2. Scroll down to the lower half of the page and click the drop-down arrow for the Status field. 
3. Select Republish. 
4. Click the Save button. 
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Select a Template for a Page 
This feature will be available at a later date. 
 

1. Click the Template button. 
2. Select one of the following templates:  Two Columns, Text and Left Side Image, Text and Right Side 

Image, or One Column. 

 
 Placeholder text is inserted into the page. 

 
3. Replace the placeholder text with your content. 

 
 
Using Spell Check 
The spell check feature works very similar to those checkers found in Microsoft Word and in other applications.  
The spell checker automatically places a red squiggle under the word that is misspelled. 
 
To spell check: 

1. Right mouse click on the misspelled word. 
2. From the pop-up menu, select the correct spelling or choose Ignore. 

OR 
Click the Spell Check button and then select Check Spelling. 

 
 
Paste Text from Another Application 

1. Copy the text from another document (such as Word, etc.). 
2. Click in the location where you want to paste the text. 
3. Press Ctrl-V. 

OR   
Click the Paste as Plain text button. 

4. If you receive the prompt, “Do you want to allow this web page to access your clipboard?”, click the 
Allow Access button. 
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Create a Link to a Page within Your Site   
1. Select the text or image for which you want to create a link. 
2. Click the LinkIt+ button. 
3. In the Search Content dialog box, type the word(s) associated with the page you want to link to. 

 
4. From the list of results, click on the page that you wish to link to. 

 
OR 

If the desired page does not appear in the list…   
a. Click outside the Search Content dialog box. 
b. Open another tab within your web browser and browse to the page you want to link to. 
c. Copy the web address. 
d. Return to the Search Content dialog box. 
e. Paste the web address into the Target Path box. 

5. Click the Insert Link button. 
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Create a Link to a Page Outside Your Site 
1. Select the text or image for which you want to create a link. 
2. Click the Link button.   
3. For the Link Type, select URL. 
4. In the URL box, type or paste the complete web address. 

 If you paste the complete web address, it will automatically select the correct prefix of http:// or 
https:// in the Protocol box. 

 If you type the web address without the prefix of http:// or https://, you will need to select the 
correct protocol. 

 
5. Click OK. 
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Create an Anchor 
An anchor is used with a link; it allows you to jump to a specific location within the same page.  You must create 
the anchor first before you create the link. 
 

1. Select the text or image for which you want to create an anchor. 
2. Click the Anchor button. 

 The Anchor button looks like a flag. 
3. At the Anchor Properties dialog box…  Type the name of the anchor. 

 Do not use spaces or special characters within the anchor name.  Exception:  You can use a 
hyphen. 

 Use title case for anchors consisting of several “words”.  Example:  MoreInfo 
4. Click OK. 

 
 
Create a Link to an Anchor 

1. Select the text or image for which you want to create a link. 
2. Click the Link button. 
3. At the Link dialog box…  Click the drop-down arrow for Link Type and select:  Link to an Anchor in the 

Text. 
4. Click the drop-down arrow for By Anchor Name and select the desired anchor. 

 
5. Click OK. 

 
 
Remove an Anchor 

1. Right mouse click on the text that contains an anchor. 
2. From the short-cut menu, select:  Remove Anchor. 
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Create an Email Link 
1. Select the text or image for which you want to create an email link. 
2. Click the Link button. 
3. At the Link dialog box…  Click the drop-down arrow for Link Type and select:  Email. 
4. In the Email Address box, type the complete email address. 

 
5. Optional:  Type in the subject of the message in the Message Subject box. 
6. Optional:  Type the text of the message in the Message Body box. 
7. Click OK. 

 
 
  

CDudas\P:\My Documents\Office Documents\Seminars\How-To-Guides\Drupal\Drupalcontentediting.Docx\04.10.13\Updated-08.29.13\Page 15 of 34 
 



Link to an Existing File 
File types that are acceptable for use on the college’s web site include: .doc, .docx, .gif, .jpg, .pdf, .png, .ppt, and 
pptx.  File sizes should not exceed 6 MB. 
 

1. Select the text that you wish to use as the link to the file. 
2. Click the Link button. 
3. At the Link dialog box…  Click the Browse Server button. 

 
4. At the File Browser screen…  Navigate to and open the folder that contains the file you wish to link to. 
5. Click on the file that you wish to link to. 

 
6. Click the Insert File button. 
7. Click OK. 

 
  

CDudas\P:\My Documents\Office Documents\Seminars\How-To-Guides\Drupal\Drupalcontentediting.Docx\04.10.13\Updated-08.29.13\Page 16 of 34 
 



Upload and Link to a File 
File types that are acceptable for use on the college’s web site include: .doc, .docx, .gif, .jpg, .pdf, .png, .ppt, and 
pptx.  File sizes should not exceed 6 MB. 
 

1. Select the text that you wish to use as the link to the file. 
2. Click the Link button. 
3. At the Link dialog box…  Click the Browse Server button. 
4. At the File Browser screen…  Navigate to the folder where you want to upload the file. 

 
5. Click the Upload button (located at the top of the screen). 

 
6. At the File Upload dialog box…  Click the Browse button. 

 
7. Navigate to the folder on your PC that contains the file you wish to link to. 
8. Click on the file name that you wish to upload. 
9. Click the Open button. 
10. At the File Upload dialog box… Click the Upload button (located at the bottom of the screen). 

 
 
-continued- 
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11. After the file has been uploaded, close the File Upload screen. 
 You will now see the list of files that have been uploaded to this area. 

 
 

12. At the File Browser screen…  Click on the file that you want to link to. 
13. At the File Browser screen…  Click the Insert File button (located at the top of the screen). 
14. At the Link dialog box…  Click OK. 

 
 
Remove a Link 

1. Select the linked text or image. 
2. Click the Unlink button. 
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Upload and Insert a New Image 
Image types that are acceptable for use on the college’s web site include:  .gif, .jpg, .jpeg, and .png.  File sizes 
should not exceed 6 MB. 
 

1. Click in the location where you want to insert an image. 
2. Click the Image button. 
3. Click the Image Info tab (selected by default). 

 
4. Click the Browse Server button. 
5. At the File Browser screen…  Navigate to and open the folder where you want to upload the image to. 

 
6. Click the Upload button (located at the top of the screen). 

 
 
-continued-  
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7. At the File Upload dialog box…  Click the Browse button. 

 
8. Navigate to the folder on your PC that contains the image you wish to upload. 
9. Click on the file name of the image. 
10. Click the Open button. 
11. At the File Upload dialog box…  Click the Upload button (located at the bottom of the screen). 

 
12. After the file has been uploaded, close the File dialog box. 

 You will now see the list of files that have been uploaded to this area. 

 
13. Click on the name of the file that you want to insert. 

 If needed, resize the image.  See the section, Resize an Image, for instructions. 
14. Click the Insert File button (located at the top of the screen). 
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15. At the Image Properties dialog box…  In the Alternative Text box, enter a description that explains the 
purpose or content of that image. 
 People who are blind use screen readers to read the text aloud.  When a screen reader encounters 

an image, it will read the alt text to the person.  

  
16. If desired, you can format the image with a border or add horizontal and vertical spacing. 

a. To do so, enter a number in the appropriate box(es). 
17. Select an alignment (i.e. left or right). 
18. Click OK. 

 
 
  

CDudas\P:\My Documents\Office Documents\Seminars\How-To-Guides\Drupal\Drupalcontentediting.Docx\04.10.13\Updated-08.29.13\Page 21 of 34 
 



Insert an Existing Image 
1. Click in the location where you want to insert an image. 
2. Click the Image button. 
3. Click the Image Info tab (selected by default). 

 
4. Click the Browse Server button. 
5. At the File Browser screen…  Navigate to and open the folder that contains the image you wish to insert. 

 
6. Click on the name of the file that you want to insert. 

 
7. If needed, resize the image. 

 See the section, Resize an Image, for instructions. 
8. Click the Insert File button (located at the top of the screen). 
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9. At the Image Properties dialog box…  In the Alternative Text box, enter a description that explains the 
purpose or content of that image. 
 People who are blind use screen readers to read the text aloud.  When a screen reader encounters 

an image, it will read the alt text to the person.  

 
10. If desired, you can format the image with a border or add horizontal and vertical spacing. 

a. To do so, enter a number in the appropriate box(es). 
11. Select an alignment (i.e. left or right). 
12. Click OK. 
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Resize an Image 
You can resize an image several different ways.   ??? --- Should they be able to resize an image to any 
dimension?  Editors can do this via Resize menu.   Need to add a larger size (360x240) to Thumbnails menu. 
 
These instructions assume that: 

• the image has already been uploaded to the desired folder 
• you are at the File Browser screen 

 
To resize an image using predefined sizes: 

1. At the File Browser screen…  Click on the image you wish to resize. 
2. Click the Thumbnails button.  

 
3. From the Thumbnails menu, select the appropriate size. 
4. Click the Create Thumbnails button. 

 The newly created image will have a prefix added to the file name.  The prefix corresponds to the 
image size you selected.  Example:  medium_adultadmissions.jpg 

5. Close the Thumbnails dialog box. 
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Create a Table 
Tables should only be used if absolutely needed, such as a table which is presenting data.  Further, if you use a 
table, be sure to include headers, a caption, and a summary.  Tables should NOT be used to format content on a 
page. 
 
The example below illustrates a very simple table.  Generally, you would not use a table for information as 
simplistic as this. 
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To create a table: 
1. Click in the location where you want to insert a table. 
2. Click the Table button. 
3. Type the desired number of rows into the Rows box. 
4. Type the desired number of columns into the Columns box. 
5. At the Headers box, select the appropriate header. 

 The header identifies whether a row and/or column contains a heading name. 
6. In the Border Size box, type a number to indicate the thickness of the border. 

 For no border, type a zero. 
7. At the Alignment box, select the appropriate alignment. 
8. In the Width box, type the desired table width (in percentage).  Add a percent sign immediately after 

the number. 
 Example:  50% 

9. Optional:  In the Height box, type the desired table height. 
10. In the Cell Spacing box, type the desired cell spacing (in pixels).  

 Cell spacing refers to the space between cells. 
11. In the Cell Padding box, type the desired cell padding (in pixels). 

 Cell padding refers to the margins within the cell. 
12. In the Caption box, type a brief caption for the table. 

 A caption is a title for the table. 
13. In the Summary box, type a summary that describes the organization of the table. 

 The summary is not displayed visually, but is used by a screen reader.  A screen reader is used by a 
blind person to read the information out loud. 

 The summary provides a brief overview of how data has been organized into a table or an 
explanation of how to navigate the table.  
Example:  The first column contains the pick-up/drop-off times for the shuttle bus.  The second 
column lists the locations for the shuttle bus stops. 

 The summary should not duplicate the caption. 

 
14. Click OK. 
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Modify a Table 
1. Right-click in the table. 
2. From the short-cut menu, select one of the following: 

a. Cell and then choose one of the desired actions: 
• Insert Cell Before, Insert Cell After, Delete Cells, merge Cells, Merge Right, Merge Down, 

Split Cell Horizontally, Split Cell Vertically 
b. Row and then choose one of the desired actions: 

• Insert Row Before, Insert Row After, Delete Rows 
c. Column and then choose one of the desired actions: 

• Insert Column Before, Insert Column After, Delete Columns 
d. Table Properties and then edit the desired table properties. 

 
 
Delete a Table 

1. Right-click in the table. 
2. From the short-cut menu, select:  Delete Table. 
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Add Items to Right Sidebar (i.e Information Box) 
Typically, the right side bar contains links to news, events, and to other information.  The sidebar is populated 
automatically by items which have been designated (i.e. flagged) to appear in this area. 
 

 
 
To flag a news item so that it appears in a sidebar:  Refer to the section, Create a News Article. 
 
To flag an event item so that it appears in a sidebar:  Refer to the section, Create an Event. 
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Add an Item to the Navigation Menu 
The navigation menu (i.e. the left nav) includes the main menu and submenus for your section.  Each of these 
menu groups are limited to 8 to 10 links.  To stay within these parameters, please create links within the content 
of the site.  Also, depending upon the item, it may be appropriate to include the item in your section’s sidebar 
rather than as a menu item. 

 
If you think a menu item is warranted for the left nav, please make a request by sending an email message to 
bdwebmaster@psu.edu.  Please provide the following information: 

• Section where the menu item is to be located 
• Title for the menu item 
• URL of the page that the menu item is to link to 

Once received, it will be reviewed to determine whether the request for a new menu item can be 
accommodated. 
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Create a News Article 
News articles are for announcements, office/departmental news, etc. that you wish to appear in the right 
sidebar of a section.  Unlike pages, news items give you the ability to add a caption to a photo and will 
automatically add a “Posted on” date at the top of the page.  
 
News articles will be automatically submitted to the Office of Marketing Communication.  Once received, they 
will also be considered for possible inclusion in the news section of the Penn State Behrend home page.  Note: If 
a news item is chosen to appear on the home page, OMC may need to edit or add additional information to the 
news item so that it aligns with the standard college news format.  
 

1. From the primary Drupal menu, select:  Add content.   
2. From the secondary Drupal menu, click on News. 
3. In the Title box, type the headline for the news item. 
4. In the content section, enter the desired content. 

 
5. If desired, insert a photo using one of the methods below. 

 Files must be less than 2 MB with dimensions not exceeding 480 x 320 pixels.  If the image 
dimensions are larger, then image will be automatically resized to 480 x 320 pixels. 

 

Method 1:  No Caption for Image 
a. If you do not need a caption for the photo, then upload and insert the photo by using the Image 

button. 

OR 
Method 2:  Captioned Image 
a. Scroll down and click the Browse button for the News Image box.  Caption does not display. 

 
b. Navigate to the location where the image is located on your PC. 
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c. Click on the desired image. 
d. Click the Open button. 
e. At the Create News screen, click the Upload button. 

 The screen now displays additional options for the uploaded image. 

 
f. In the Alternative Text box, enter a description that explains the purpose or content of that 

image. 
 People who are blind use screen readers to read the text aloud.  When a screen reader 

encounters an image, it will read the alt text to the person. 
g. In the Title box, type the title for the image. 

 The title will be displayed if you hover your mouse over the image.) 
h. In the Caption box, type a caption for the image. 

6. If desired, you can choose to have the news item populate a right sidebar.  To do so: 
a. Scroll down to the Flags section (near the bottom, left side of the screen). 
b. If the list of sidebars is not displayed, click on Flags. 

 
c. Click to place a checkmark in the box that corresponds to the section(s) where you want this 

item to display. 
 Do not flag a news item for a sidebar outside of your section unless the content editor for 

that section has agreed to have the item displayed in their section.   
 News items that are flagged to populate a sidebar will display in that sidebar until the flag 

is unchecked.  Or if the sidebar has reached its display limit (usually four items), the oldest 
item will rotate off.  
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7. Click the Save button. 
 Your news item will be submitted for approval.  Once approved, you will be notified via email and 

the news item will appear on your dashboard.  The news item is available to the public once you 
create a link to it.   ??? --- Pending news item shows on Published & Pending Approval dashboard. 
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Create an Event 
Events items are for any content that is related to a one-day or multiple-day event and they appear in the right 
sidebar of a section.  Unlike pages and news items, events items will automatically disappear from the sidebar 
when the event is over. 
 
Events will also be submitted to the Office of Marketing Communication for consideration for inclusion on the 
Penn State Behrend home page.  Note: If an event item is chosen to appear on the home page, OMC may need 
to edit or add to the event to align with the standard college events format. 
 

1. From the primary Drupal menu, select:  Add content.   
2. From the secondary Drupal menu, click on Event. 
3. In the Title box, type a title for the event using this format:  Date: Event Title. 

Example:  May 15: Join Us for the Admissions Open House 
4. In the Location box, type the location of the event. 
5. In the Date(s) section: 

a. If this is an all-day event where you do not want to display a beginning or ending time, click the 
All Day check box.   
OR 
If this is an event where you do want to display a beginning and an ending time, click the Show 
End Date check box. 
 If Show End Date is unchecked, only the beginning date and time will display. 

b. In the Beginning Date box, type or select the date from the pop-up calendar.   
c. In the Beginning Time box, type the beginning time (specifying the hour and minutes) along with 

either am or pm. 
 Minutes are limited to :00, :15, :30, and :45. 

d. In the Ending Time box, type or select the ending date from the pop-up calendar. 
e. In the Ending Time box, type the ending time (specifying the hour and minutes) along with 

either am or pm. 
 Minutes are limited to :00, :15, :30, and :45. 

 
6. If the event has multiple dates, click the Add Another Item button. 

a. Repeat steps 4a to 4e. 
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7. In the Body/Content area, type the event description and, if applicable, insert an image. 
8. From the Behrend Section menu, select the appropriate section.  
9. In the Event Contact Info section, type the contact person’s name, email, and phone number. 

 The phone number will automatically appear in the format of (814) 898-xxxx regardless of how it is 
entered into the field. 

 
10. If desired, you can choose to have the event item populate a right sidebar.  To do so: 

a. In the Flags section, place a checkmark in the box corresponding to section(s) where you want 
this item to display. 
 Do not flag an event item for a sidebar outside of your section unless the content editor 

from that section has agreed to have the item displayed in their section.   
 Event items that are flagged to populate a sidebar will display in that sidebar until either 

the flag is unchecked or until the event is over.  

 
11. Click the Save button. 

 Your event item will be submitted for review.  Once approved, you will be notified via email and 
the event item will appear on your dashboard.  The event item is available to the public once you 
create a link to it.  

 
CDudas\P:\My Documents\Office Documents\Seminars\How-To-Guides\Drupal\Drupalcontentediting.Docx\04.10.13\Updated-08.29.13\Page 34 of 34 

 


	Penn State Behrend Using Drupal to Edit Your Web Site
	Login to Drupal
	Logout of Drupal
	Drupal Menus
	Overview of the Dashboard
	Access the Dashboard
	View Pages that are Published
	View Pages that are Pending Approval
	View Pages that are Unpublished
	View or Edit a Page from the Dashboard
	Sort the Columns on the Dashboard
	Search the Dashboard
	Search for a Page

	Overview of the Tabs
	Overview of the Editing Toolbar
	Create, Save, and Publish a New Page
	Edit and Save an Existing Page
	Close a Page (without saving)
	Preview a Page
	Delete a Page
	Unpublish a Page
	Republish a Page
	Select a Template for a Page
	Using Spell Check
	Paste Text from Another Application
	Create a Link to a Page within Your Site
	Create a Link to a Page Outside Your Site
	Create an Anchor
	Create a Link to an Anchor
	Remove an Anchor
	Create an Email Link
	Link to an Existing File
	Upload and Link to a File
	Remove a Link
	Upload and Insert a New Image
	Insert an Existing Image
	Resize an Image
	Create a Table
	Modify a Table
	Delete a Table
	Add Items to Right Sidebar (i.e Information Box)
	Add an Item to the Navigation Menu
	Create a News Article
	Create an Event


